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[bookmark: _Toc221879749]ВВЕДЕНИЕ

Общеизвестно высказывание о том, что тот, кто владеет информацией, тот владеет и миром. Иное сообщение стоит дороже жизни.
По преданию, 13 сентября 490 года до н.э. греческий воин-гонец, прибежавший из Марафона в Афины, не останавливаясь в пути, упал замертво, но донес весть о победе над персами.
Победу в Великой Отечественной войне обеспечили во многом связисты, не зря в книгах и кинофильмах о том времени упоминается ВЧ-связь, посредством которой Ставка Верховного Главнокомандующего выходила на командующих фронтами. Высокочастотный (ВЧ) канал позволял иметь надежное и, главное, секретное общение на больших расстояниях.
Много воды утекло с тех пор, информация стала открытой и доступной, благодаря новым способам передачи сообщений, на экране дисплея мы можем видеть информацию со всего мира. Интернет связал пользователей двух полушарий планеты в единую обширную сеть WWW (World Wide Web), из паутины которой бывает непросто выбраться любознательному человеку.На сегодняшний день в мире существует около 2 млн. серверов и по последним данным более 280 млн. пользователей в Интернет. Таким образом Интернет становится тотальным в планетарных масштабах источником всевозможнейшей  информации и средой интерактивного общения.
Важной особенностью этой обширнейшей информационной базы является её постоянное обновление и создание новых страниц. Среди многообразия выбора программ для создания веб-страниц (Microsoft FrontPage, AOLpress, HomeSite 5, CoffeeCup HTML Editor 8.5, NetObjects Fusion 5.0, Macromedia Dreamweaver) я бы хотел выделить и подробно рассмотреть программу Microsoft Word.
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[bookmark: _Toc221879750]1.ЭЛЕКТРОННЫЕ ДОКУМЕНТЫ

Еще не так давно Microsoft Word использовался исключительно при создании документов для дальнейшей их печати на листах бумаги. Но в связи с постепенным переходом к безбумажным технологиям каждая новая версия программы предоставляет все больше средств для формирования альтернативного конечного продукта – документа, работа с которым будет вестись на компьютере, без его распечатки. В дальнейшем мы будем называть такие документы электронными. Это могут быть обычные документы Word или, теперь более часто встречающийся вариант – веб-страницы, то есть документы в формате HTML (Hypertext Markup Language – язык разметки гипертекста), размещенного на сервере в Интернете или в интранете компании (локальной сети, обладающими свойствами Интернета).
Документы такого типа не только приводят к экономии бумаги и сохранению лесов на планете, но и имеют другое, очень важное достоинство: они могут быть динамическими (меняющимися с течением времени) и интерактивными (реагирующими на происходящие действия). Часто они содержат гиперссылки, предназначенные для перехода к другим файлам, интерактивные формы для сбора информации, фреймы, позволяющие одновременно просматривать несколько страниц, фон, узоры, движущийся текст или графику, видео и звуковые клипы.
Для создания веб-страниц и других электронных документов Word в основном используются обычные методы редактирования и форматирования.
[bookmark: _Toc72433160][bookmark: _Toc221879751]1.1. Поля в электронных документах
Полями называются динамические элементы, вставляемые в документы для сбора данных и отображения постоянно изменяющейся информации. Например, существуют поля, показывающие дату и время, имя автора документа или количество символов в тексте, служащие для перехода в другое место документа, запускающие макросы, дающие команду принтеру, выполняющие вычисления, подсчитывающие количество элементов документа или запрашивающие у пользователя определенные сведения.
Чтобы вставить поле в документ, выполните следующее:
1. Выберете команду Вставка ► Поле (Insert ► Field), чтобы отобразить диалоговое окно Поле.
2. Выберите в списке Категории (Categories) тип поля
3. Выберите определенное поле в списке Поля (Field Names). Ниже отобразится описание выделенного в данный момент поля.
4. [bookmark: _Toc72433161]Задайте свойства и параметры поля. Их состав зависит от выбранного поля.
[bookmark: _Toc221879752]2. СОЗДАНИЕ ВЕБ-СТРАНИЦ

Начиная с Word 2000, формирование веб-страниц перестало сильно отличаться от создания стандартных документов. Команды Word и интерфейс программы практически не зависят от того, над каким документом ведется работа: над обычным текстом или над веб-страницей в формате HTML, а существующие небольшие различия мы рассмотрим далее.
Поскольку формат HTML теперь является одним из стандартных форматов Word, применяющимся наравне с обычными форматами .doc или .rtf (Rich Text Format – расширенный текстовый формат), то при сохранении документов в этом формате остаются доступными большинство основных средств редактирования (исключения мы рассмотрим ниже). Даже если какая-то настройка не влияет на отображении документа в браузере, например, размер полей страницы, все подобные параметры сохраняются в HTML-файле и используются при открытии документа в окне Word. Соответственно, можно сохранить обычный документ Word в формате HTML, а позже открыть HTML-файл и преобразовать его назад в документ Word  почти без потери элементов форматирования.
Для создания в Word веб-страницы требуется выполнить три основных действия.

[bookmark: _Toc72433162][bookmark: _Toc221879753]2.1. Создание новой веб-страницы
Выберите команду Файл ► Создать (File ► New) и в открывшейся области задач Создание документа (New Document) щелкните на одной из ссылок:
- Новая веб-страница (Blank Web Page) создает пустую веб-страницу
- Чтобы создать веб-страницу на основе встроенного шаблона, щелкните на ссылке Общие шаблоны (General Templates), откройте вкладку Веб-страницы (Web Pages) и выберите подходящий шаблон. При этом сформированная веб-страница уже будет содержать разметку текста и графические элементы, соответствующие выбранному типу. Теперь можно изменить страницу и добавить на нее собственные элементы.
- Можно создать набор связанных между собой веб-страниц (называемый веб-узлом или сайтом). Для этого выберете на вкладке Веб-страницы элемент Мастер веб-страниц (Web Page Wizard). Мастер веб-страниц позволяет сформировать узел из нескольких страниц (для каждой можно выбрать шаблон), определить папку для хранения, организовать систему гиперссылок, соединяющих страницы, и применить тему для однотипного оформления страниц. После создания мастером веб-узла можно открыть, изменить и добавить различные элементы на отдельные страницы.
- Чтобы открыть существующую веб-страницу или обычный документ Word, щелкните на ссылке Документы (Documents), которая заменяется ссылкой  Другие документы (More documents), если область задач содержит список последних открывавшихся файлов, и выберите файл в диалоговом окне Открытие документа (Open).

[bookmark: _Toc72433163][bookmark: _Toc221879754]2.2. Редактирование и форматирование веб-страницы
Введите или отредактируйте текст веб-страницы, добавьте графические элементы, отформатируйте документ с помощью стандартных инструментов в Word. При этом учтите следующее:
- Некоторые из элементов форматирования не отображаются или не поддерживаются большинством браузеров: отрицательные отступы абзацев, диагональные границы таблиц, расположение текста в ячейках таблиц по вертикали, границы страниц,  колонки, автоматическая расстановка переносов, подложка, колонтитулы, размеры полей и другие настройки, сделанные в диалоговом окне Параметры страницы, некоторые элементы символьного форматирования, например стили подчеркивания, тени и анимации текста. Кроме того, вид части элементов в браузере может отличаться от их вида в окне Word, например, текст может некорректно выравниваться по позициям табуляции, узорчатая заливка становиться сплошной, а обтекаемый текстом графический объект или таблица сдвигаются к левому или правому краю абзаца.
- При редактировании веб-страниц Word обычно позволяет применять средства, не поддерживаемые браузером. Как упоминалось выше, эти элементы сохраняются в HTML-файле и используются при последующих открытиях документа в Word. Но программа предоставляет возможность запретить использование большинства инструментов символьного, абзацного и табличного форматирования, несовместимых с определенным браузером. Для этого выберите команду Сервис ► Параметры, откройте вкладку Общие, нажмите кнопку Параметры веб-документа (Web Options) и перейдите на вкладку Обозреватели (Browsers). На ней выберите в раскрывающемся списке версию браузера и убедитесь, что в расположенном ниже списке установлен флажок Отключение компонентов, не поддерживаемых этими обозревателями (Disable Features Not Supported By These Browsers. Word во всех диалоговых окнах отключит не поддерживаемые средства. А если документ уже содержит какой-либо из этих атрибутов форматирования, то при сохранении файла программа сделает запрос и, получив положительный ответ, преобразует подобные элементы, если это возможно, в аналогичные, но поддерживаемые браузером. Учтите, что Word отключает средства только для веб-страниц, поэтому, чтобы запретить их использование для обычного документа, который потом станет веб-страницей, следует сохранить его в формате HTML.
- Интерфейс Word при работе с веб-страницей немного отличается от стандартного. Например, кнопка Создать (New Blank Document) заменяется кнопкой Новая веб-страница (New Web Page). В меню Файл появляется команда Версии (Versions), а в меню Вид – команда Источник  HTML (HTML Source), позволяющая напрямую редактировать HTML-код веб-страницы.
- Помимо основных инструментов Word предоставляет элементы и средства форматирования, предназначенные специально для создания веб-страниц (и других электронных документов). Это гиперссылки, линии-разделители, звуковые и видеоклипы, фоновые звуки, бегущие строки, формы для сбора информации, фреймы, позволяющие одновременно просматривать несколько страниц, веб-компоненты, служащие для перемещения на другие страницы и просмотра информации на групповых веб-узлах. В средства форматирования входят фоновый цвет, узор и темы.
- Лучше всего редактировать веб-страницы в режиме веб-документа, в котором документ отображается почти так же, как в большинстве популярных браузеров. Конечно, для более точного просмотра следует открыть документ в браузере, выбрав команду Файл ► Предварительный просмотр веб-страницы (File ► Web Page Preview).

[bookmark: _Toc72433164][bookmark: _Toc221879755]2.3. Сохранение веб-страницы
Если на шаге 2.1 создавалась новая веб-страница или открывалась существующая, можно воспользоваться обычными командами Сохранить или Сохранить как – документ по умолчанию сохраняется в формате HTML. Но если шла работа со стандартным документом Word, следует выбрать команду Файл ► Сохранить как веб-страницу (File ► Save As Web Page).
Word использует несколько форматов HTML. Задать специфичный формат позволяет раскрывающийся список Тип файла (Save As Type) в диалоговом окне Сохранение документа:
- Веб-страница (*.htm; *.html). Веб-страница сохраняется в HTML-файле, но все графические и другие сопутствующие данные записываются в отдельные файлы. При этом запоминаются все элементы Word, содержащиеся в документе вне зависимости от их поддержки браузерами.
- Веб-архив (*.mht; *.mhtml). Весь документ сохраняется в одном файле веб-архива. Также запоминаются все элементы Word.
- Веб-страница с фильтром (*.htm; *.html). Веб-страница записывается так же, как и в первом варианте, но сохраняется только необходимая информация, а неподдерживаемые браузерами элементы Word отбрасываются.
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Перечисленные ниже и рассматриваемые в следующих подразделах элементы особенно полезны на веб-страницах, за исключением веб-компонентов в обычных документах Word, предназначенных для чтения в оперативном режиме:
1. Гиперссылки
2. Горизонтальные разделяющие линии – разделители
3. Видео и звуковые клипы, фоновые звуки
4. Бегущая строка
5. Веб-формы
6. Рамки, служащие для создания фреймов
7. Веб-компоненты

[bookmark: _Toc72433166][bookmark: _Toc221879757]3.1. Добавление и использование гиперссылок
Гиперссылки бывают текстовые или графические. Они связывают фрагменты текста или рисунок с целевым объектом, который может быть веб-страница, документ Office, любой другой файл или папка, расположенные на жестком или сетевом диске или узле Интернета. В качестве целевого объекта также может использоваться определенное место в текущем документе или в другом файле. Или, например, электронный адрес. В результате щелчка на гиперссылке на экран выводится целевой объект или отправляется сообщение по целевому электронному адресу. Щелкать на гиперссылке можно, когда документ открыт в Word или отображается в браузере (для веб-страниц). Гиперссылки используются в документах Word любого типа, но, конечно на веб-страницах они имеют особое значение, потому что представляют средство перехода между страницами веб-узла или связи с другими веб-узлами.
Создается гиперссылка следующим образом:
1. Выделите текст или рисунок, к которому требуется присоединить гиперссылку, или расположите курсор там, куда нужно вставить гиперссылку. Во втором случае ее тип будет определен позже.
2. Откройте диалоговое окно Добавление гиперссылки (Insert Hyperlink), выбрав команду Вставка ► Гиперссылка (Insert ► Hyperlink), нажав кнопку Добавление гиперссылки на стандартной панели инструментов или нажав клавиши Ctrl+K.
3. Введите или отредактируйте текст гиперссылки в поле Текст (Text To Display). Пропустите это действие, если на шаге 1 был выделен нужный текст или гиперссылка назначается рисунку.
Панель Связать с (Link To), расположенная в левой части диалогового окна, предназначается для определения типа целевого объекта гиперссылки:
- если это существующий документ или веб-страница, выделите вариант Файлом, веб- страницей (Existing File Or Web Page);
- если гиперссылка будет соединена с конкретным местом в документе, выделите вариант Местом в документе (Place In This Document);
- чтобы создать новый документ или веб-страницу и сделать его целевым объектом гиперссылки, выделите Новым документом (Create New Document);
- вариант Электронной почтой (E-Mail Address) соединяет с электронным адресом – щелчок на гиперссылке вызывает отправку письма по этому адресу.
Остальные элементы диалогового окна зависят от выбранного типа целевого объекта.
4. Если на шаге 3 был выбран первый вариант, определите целевой документ или веб-страницу одним из следующих методов:
- Введите путь к целевому файлу или его URL в поле Адрес (Address).
- Чтобы выбрать целевой файл или папку на локальном или сетевом  диске, щелкните на кнопке Текущая папка (Current Folder) и выделите файл в основном списке либо с помощью раскрывающегося списка Папка (Look In) и кнопки На один уровень вверх (Up One Folder) перейдите к желаемой папке. Также можно щелкнуть на кнопке Поиск файла (Browse For File) и определить целевой файл в диалоговом окне Связать с файлом (Link To File), оформленным так же, как стандартное окно Открытие файла.
- Присоедините недавно просматривавшуюся в Интернете страничку или файл с диска, щелкнув на кнопке Просмотренные страницы (Browsed Pages) и выбрав объект в основном списке.
- Чтобы присоединить недавно открывавшийся файл, щелкните на кнопке Последние файлы (Recent Files) и выберите файл в основном списке.
- Чтобы запустить поиск целевого объекта в Интернете, щелкните на кнопке Интернет (Browse The Web).
- Чтобы присоединить определенное место в целевом файле, щелкните на кнопке Закладка (Bookmark) и в открывшемся диалоговом окне укажите заголовок или закладку в документе.
5.  Если на шаге 4 был выбран вариант Местом в документе, определите целевой заголовок или закладку в основном списке.
6.  Если на шаге 4 был выбран вариант Новым документом, определите имя и расположение нового документа или веб-страницы, введя название в поле Имя нового документа (Name Of New Document) и задав путь с помощью кнопки Изменить (Change).
7.  Если на шаге 4 был выбран вариант Электронной почтой, введите целевой адрес в поле Адрес эл. почты (E-Mail Address) и при необходимости введите тему письма в поле Тема (Subject).
8.  Чтобы Word или браузер показывал всплывающую подсказку, когда указатель мыши находится над гиперссылкой, щелкните на кнопке Подсказка (Screen Tip) и введите ее текст.
9.  Наконец, нажмите кнопку OK.
Чтобы изменить определенную гиперссылку, выделите ее и откройте диалоговое окно Вставка гиперссылки, которое теперь будет называться Изменение гиперссылки (Edit Hyperlink). Здесь можно отредактировать параметры гиперссылки или удалить ее щелчком на кнопке Удалить ссылку (Remove Link).
Если щелкнуть на гиперссылке в окне Word и если целевым объектом является стандартный документ Office, можно для перемещения между посещенными местами в текущем документе и в открытых документах использовать панель инструментов Веб-узел (Web. Эта панель автоматически появляется на экране при первом щелчке на гиперссылке, но ее можно вывести самостоятельно выбрав команду Вид ► Панели инструментов ► Веб-узел или щелкнув правой кнопкой мыши на любой панели инструментов и указав Веб-узел в контекстном меню.

[bookmark: _Toc72433167][bookmark: _Toc221879758]3.2. Вставка горизонтальных разделительных  линий
С помощью горизонтальной разделительной линии можно отделять друг от друга можно отделять друг от друга различные части документа, их также применяют вместо горизонтальной границы выше и ниже абзаца. Хотя разделители являются типичным элементов веб-страниц, их можно вставлять в любые документы Word. В отличие от границ разделительная линия представляет собой отдельный элемент документа, который можно выделять, удалять, перемещать и форматировать. Ею может быть обычная плоская горизонтальная линия или графическое изображение, тогда разделитель становится декоративным элементом страницы.
Чтобы вставить горизонтальную линию, выполните следующие действия:
1. Поместите курсор в то место, где требуется разделить документ. Разделитель будет вставлен перед курсором и займет отдельную строку.
2. Выберите команду Формат ► Границы и заливка (Format ► Borders And Shading) и щелкните на кнопке Горизонтальная линия (Horizontal Line). Откроется одноименное диалоговое окно, содержащее библиотеку доступных разделителей.
3. Выделите нужную линию. Первый элемент библиотеки (в верхнем левом углу) является стандартным плоским разделителем. Word создает линию, добавляя тег <HR> - horizontal rule (горизонтальная линия). Отдельные элементы библиотеки создают разделитель из графического файла, добавляется HTML-тег <IMG> - image (изображение).
Чтобы добавить в библиотеку новую линию, щелкните на кнопке Импорт (Import) и выберите файл в открывшемся  диалоговом окне.
Диалоговое окно Горизонтальная линия позволяет искать линии по ключевому слову – его следует ввести в поле Искать текст (Search Text) и нажать кнопку Поиск (Search). Чтобы после поиска показать все линии, оставьте поле Искать текст пустым и нажмите кнопку Поиск
4. Нажмите кнопку OK.

Когда в документ  вставлена хотя бы одна линия, появляется удобный способ добавления последней из них. Щелкните на стрелке вниз, расположенной рядом с кнопкой Границы (Borders) на панели инструментов Форматирование или на панели Таблицы и границы, и щелкните на элементе палитры Горизонтальная линия. А если хотя бы раз воспользоваться этим способом, для дальнейшего добавления данного разделителя достаточно будет просто щелкнуть на кнопке Границы.
Чтобы изменить положение вставленной в документ горизонтальной линии, выделите ее щелчком мыши и перетащите в новое место. Нажатие клавиши Delete при выделенной линии удаляет ее.
Чтобы отформатировать выделенную горизонтальную линию, откройте диалоговое окно Формат горизонтальной линии (Format Horizontal Line) с помощью команды Формат ► Горизонтальная линия или дважды щелкнув на линии. Это диалоговое окно позволяет настроить ширину, высоту и выравнивание линии любого типа. Кроме того, можно изменить цвет и обрезку стандартной линии, цвет, яркость и контраст графической линии. Учтите, что применение темы приведет к изменению всех разделителей в документе.

[bookmark: _Toc72433168][bookmark: _Toc221879759]3.3. Добавление фильмов и звуков
Чтобы оживить документ, можно вставить в него клип или фоновый звук. Эти элементы функционируют при просмотре документа Word и веб-страницы в браузере.
Добавить видеоклип или фоновый звук можно с помощью панели инструментов Веб-компоненты (Web Tools). Чтобы отобразить ее, выберите команду Вид ► Панели инструментов ► Веб-компоненты или команду Веб-компоненты (Web Tools) в контекстном меню, появляющемся при щелчке правой кнопкой мыши на любой панели инструментов.
Видеоклип или фильм представляет собой последовательность кадров со звуком, показываемых в прямоугольной рамке, находящейся в документе. Чтобы вставить видеоклип, выполните следующие действия:
1. Щелкните на кнопке Фильм (Movie) на панели инструментов Веб-компоненты. Откроется одноименное диалоговое окно.
2. В поле Фильм (Movie) введите путь к файлу, содержащему видеоклип, или нажмите соответствующую кнопку Обзор (Browse) и определите положение файла в диалоговом окне Открыть (Open). Файлы, в которых хранятся видеоклипы, имеют различные форматы. Word поддерживает стандартные файлы, имеющие следующие расширения: .avi, .mov, .movie, .mp2, .mpeg, .mpg и .qt.
3. При желании в диалоговом окне Фильм можно задать или изменить следующие настройки:
- Чтобы браузер показывал неподвижный рисунок, когда файл с клипом недоступен, введите путь файла рисунка в поле Замещающий рисунок (Alternate Image) или нажмите кнопку Обзор и определите положение рисунка. Следует указать файл изображения с расширением .gif или .jpeg.
- Чтобы браузер отображал текст, если недоступны клип и рисунок, введите в поле Замещающий текст (Alternate Text).
- Задайте момент проигрывания клипа, выбрав подходящий пункт в списке Начинать (Start).
- Можно определить, сколько раз будет проигрываться клип после запуска. Для этого выберете любой пункт списка Число повторов (Loop). Если нужно, чтобы клип проигрывался постоянно, установите вариант Бесконечно (Infinite).
4. Нажмите кнопку OK.

Если потребуется изменить клип, в окне Word щелкните на правой кнопкой мыши и в контекстном меню выберите команду Свойства (Properties) или дважды щелкните на клипе, чтобы открыть диалоговое окно Фильм.
Чтобы в любой момент времени просмотреть фильм в Word или в Internet Explorer, независимо от заданного количества раз проигрывания, щелкните на клипе правой кнопкой мыши и выберите в контекстом меню команду Воспроизведение (Play). Команда Остановить (Stop) этого же меню служит для остановки проигрывания клипа.
При медленном соединении с Интернетом обычно клип загружается довольно долго. Чтобы не заставлять посетителей страницы ждать загрузки клипа, можно добавить на страницу гиперссылку на клип вместо него самого.

Если к веб-странице или другому документу присоединить фоновый звук, Word или браузер начнет проигрывать его при открытии файла. Добавляется фоновый звук следующим образом:
1. Щелкните на кнопке Звук (Sound) панели инструментов Веб-компоненты. Откроется диалоговое окно Фоновый звук (Background Sound).
2. Введите путь к звуковому файлу в поле Звук (Sound) или щелкните на кнопке Обзор и определите файла в открывшемся диалоговом окне. Word поддерживает звуковые файлы следующих форматов: .wav, .mid, .midi, .rmi, .au, .aif, .aiff и .snd.
3. В списке Число повторов (Loop) выберите, сколько раз будет проигрываться файл. Вариант Бесконечно (Infinite) соответствует постоянному звучанию.
4. Нажмите кнопку OK.

Звуковые клипы аналогичны видеоклипам. После вставки звукового клипа в документе появляется значок, двойной щелчок на котором вызывает проигрывание клипа. Можно отключить фоновый звук на время работы с документом в Word, переключившись в режим конструктора. Для этого предназначается кнопка  Режим конструктора (Design Mode) панели инструментов Веб-компоненты.

[bookmark: _Toc72433169][bookmark: _Toc221879760]3.4. Вставка бегущей строки
На веб-страницах часто используются так называемые бегущие строки – это фрагменты текста, перемещающиеся по ширине документа. Они украшают страницу и привлекают внимание к тексту. Чтобы вставить бегущую строку, щелкните на кнопке Бегущая строка (Scrolling Text) панели инструментов Веб-компоненты, затем введите текст и определите другие настройки в диалоговом окне Бегущая строка.

[bookmark: _Toc72433170][bookmark: _Toc221879761]3.5. Создание веб-форм
Веб-форма – это набор таких элементов, как флажки, кнопки, списки и текстовые поля, служащие для сбора сведений от читателей электронного документа Word или веб-страницы. Например, на веб-страницу можно добавить форму, позволяющую посетителям запрашивать информацию, просить прислать им информационный бюллетень или оставлять свои имена и комментарии в гостевой книге.
Чтобы вставить веб-форму, выполните следующее:
1. Расположите курсор там, где будет находиться первый элемент формы.
2. Выведите на экран панель инструментов Веб-компоненты, выбрав команду Вид ► Панели инструментов ► Веб-компоненты.
3. Вставьте элемент. Для этого нужно щелкнуть на подходящей кнопке панели инструментов. Программа сделает следующее:
- Вставит в документ верхнюю и нижнюю границы формы.
В дальнейшем элементы формы следует располагать между этими границами.
- Переключится в режим конструктора, в котором можно изменять или добавлять элементы формы. Если выйти из этого режима, элементы начинают функционировать в соответствии со своим назначением, то есть разрешается установка флажков или ввод текста в текстовые поля. Для переключения в режим конструктора и обратно служит кнопка Режим конструктора (Design Mode) панели инструментов Веб-компоненты.
Обязательно вставьте в форму кнопку для передать данных – это может быть или кнопка Submit (щелкните на кнопке Отправить(Submit) на панели инструментов Веб-компоненты) или кнопка с рисунком (щелкните на кнопке Отправить с изображением (Submit With Image) той же панели инструментов).
Любая из этих двух кнопок предназначается для отправки пользователем введенных в форму данных.
Кроме того, форма может содержать любой текст, описывающий ее элементы, предоставляющий инструкции или другую информацию.
4. Если требуется, настройте элементы формы. Для этого дважды щелкните на элементе и определите его параметры в диалоговом окне Свойства (Properties).
У кнопок отправки данных есть свойство Action (Действие). Ему можно назначить URL вспомогательной программы или сценарий на сервере, который получает и обрабатывает информацию формы. Также свойству Action можно назначить электронный адрес через протокол mailto. Тогда в результате щелчка на кнопке отправки текущее содержимое формы посылается в виде электронного сообщения по указанному адресу.
5. Закончив создание формы, щелкните на кнопке Режим конструктора, чтобы вернуться к обычному режиму редактирования.

[bookmark: _Toc72433171][bookmark: _Toc221879762]3.6. Рамки
В окне Word или веб-браузере можно демонстрировать одновременно несколько документов, показывая их в отдельных фреймах или рамках, представляющих собой настраиваемые области окна.
Мастер веб-страниц предоставляет самый быстрый способ создания набора веб-страниц, отображаемых во фреймах. Кроме того, для создания документа с рамками или добавления рамок можно воспользоваться командой Рамки (Frames) меню Формат. А для удаления, изменения рамок, редактирования их свойств и свойств документов с фреймами предназначается панель инструментов Рамки (Frames). С помощью как команды меню, так и панели инструментов можно создать оглавление в отдельной рамке.

[bookmark: _Toc72433172][bookmark: _Toc221879763]3.7. Добавление веб-компонентов
Word 2002 предоставляет несколько компонентов веб-страницы, которые позволяют ее посетителям переходить на другие страницы или просматривать информацию, хранящуюся на корпоративном веб-узле SharePoint. Эти компоненты можно добавлять только на веб-страницы, размещенные на веб-серверах с подходящим программным обеспечением (требования перечислены ниже).
►Панель ссылок (Link Bar) – это готовый набор кнопок с гиперссылками, дающий возможность читателям страницы перемещаться к другим страницам или документам текущего веб-узла, так и других узлов в Интернете. Чтобы воспользоваться панелью ссылок, необходимо разместить страницу на веб-сервере, на котором работает программное обеспечение Microsoft FrontPage, - серверные расширения 2000 или SharePoint Team Services.
►Представление списка (List View) – позволяет посетителю страницы просматривать и отслеживать элементы, хранящиеся в списках на групповом веб-узле SharePoint. В интерактивных списках содержится информация разных типов: реклама, объявления, контактные сведения, новости, ссылки на другие узлы Интернета, отчеты, краткое изложение задач, которые требуется выполнить, и вспомогательная информация. Чтобы иметь возможность воспользоваться интерактивным списком, следует разместить страницу на веб-сервере с установленным программным обеспечением SharePoint Team Services.
►Представление библиотек документов (Document Library View) позволяет посетителю страницы просматривать документы, хранящиеся в библиотеках, расположенных на веб-узлах совместного доступа SharePoint. Чтобы добавить его, необходимо разместить страницу на веб-сервере, на котором установлено расширение SharePoint.




























[bookmark: _Toc72433173][bookmark: _Toc221879764]4. ФОРМАТИРОВАНИЕ ВЕБ-СТРАНИЦ

Наиболее популярными средствами форматирования, используемых именно на веб-страницах и других электронных документах Word и предоставляемыми программой, являются:
1. Фон
2. Темы

[bookmark: _Toc72433174][bookmark: _Toc221879765]4.1. Фон
На веб-страницах в качестве фона можно использовать сплошной цвет, стандартную узорчатую заливку и рисунок, извлекаемый из графического файла, который определяется с помощью подменю Фон (Background) меню Формат.
- Чтобы фоном стал стандартный сплошной цвет, выберите один из цветов в палитре подменю.
- Получить возможность выбора из большого спектра сплошных цветов или создать дополнительный цвет можно, воспользовавшись командой Другие цвета (More Colors).
- Чтобы применить в качестве фона узор, текстуру или рисунок, выберите команду Способ заливки (Fill Effects), которая открывает одноименное диалоговое окно. Его первые три вкладки – Градиентная (Gradient), Текстура (Texture) и Узор (Pattern) – предоставляют большую коллекцию стандартных фоновых текстурных заливок. Четвертая вкладка Рисунок (Picture) позволяет использовать для фона рисунок, находящийся в каком-либо графическом файле.
- Команда Нет заливки (No Fill) удаляет назначенный фон.

[bookmark: _Toc72433175][bookmark: _Toc221879766]4.2. Тема
Можно изменить вид веб-страницы или обычного документа Word, применив к нему тему. Темой называется разработанная схема форматирования, в результате воздействия которой все элементы документа принимают согласованный друг с другом вид. Office XP предоставляет почти 70 различных тем. Тема влияет на следующие элементы документа:
-   Шрифт, размер символов, цвет и другие параметры текста документа. Тема изменяет оформление текста, редактируя обычный стиль и стили заголовков.
- Фон страницы. Может применяться как сплошной цвет, так и текстурная заливка.
- Изображения,    используемые в качестве  горизонтальных разделительных линий и маркеров маркированных списков.
-   Цвет текста гиперссылок, как просмотренных, так и нет.
-   Цвет границ таблиц.
Чтобы применить тему к  текущему документу или веб-странице, выполните следующие действия:
1. Выберите команду Формат ► Тема (Format ► Theme). Откроется диалоговое окно Тема.
2. Выделите в списке слева желаемую тему или команду нет темы (No Theme), чтобы удалить ранее примененную тему. В области справа  отобразится пример воздействия выделенной темы на текст.
3. Задайте следующие параметры:
- Живые цвета (Vivid Colors) – приводит к использованию ярких цветов.
- Активная графика (Active Graphics) – отображает все рисунки с анимацией, содержащиеся в теме.
- Фоновый рисунок (Background Image) – отображает фоновую заливку, включенную в тему. При снятом флажке показывается сплошной цвет фона, а не текстура.
- Чтобы в дальнейшем по умолчанию использовать выбранную тему для всех новых веб-страниц, создаваемых в Word, щелкните на кнопке По умолчанию (Set Default). Это не повлияет на формат обычных документов, создаваемых в Word.
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Можно определить несколько параметров, влияющих на способ создания веб-страниц программой Word, выбрав команду Сервис ► Параметры, открыв вкладку Общие и щелкнув на кнопке Параметры веб-документа (Web Options) раскрывающегося меню Сервис (Tools) диалогового окна Сохранение документа. Теперь нужно настроить параметры на вкладках этого диалогового окна.
- На вкладке Обозреватели (Browsers)тможно отключить средства форматирования, не поддерживаемые определенными браузерами, и задать основной набор параметров. При выборе конкретного браузера в верхнем списке Word автоматически устанавливает в нижнем списке настройки, совместимые с этим браузером.
- Чтобы изменить метод сохранения веб-страниц, откройте вкладку Файлы (Files).
- Вкладка Картинки (Pictures) используется для определения размера и разрешения стандартного монитора, на котором будет просматриваться создаваемая веб-страница, так чтобы Word мог оптимизировать отображение графики. По умолчанию размер экрана равен 800 на 600 точек и разрешение 96 точек на дюйм.
- На вкладке Кодировка (Encoding) определяется язык, на котором написан текст веб-страницы.
- Вкладка Шрифты (Fonts) позволяет задать набор знаков, подходящий для языка веб-страницы, или указать используемый по умолчанию шрифт и его размер.

Кроме того, можно сделать так, чтобы в некоторых диалоговых окнах (например, в окнах Абзац и Табуляция) Word в качестве единиц измерения использовал пикселы. Для этого установите флажок Отображать пикселы для средств HTML (Show Pixels For HTML Features) на вкладке Общие диалогового окна Параметры.
Если открыть HTML-файл, не имеющий стандартного расширения (.htm, .html, .mht, .mhtml, .asp), на экране вместо содержимого веб-страницы, которое отображается в браузере, появляются HTML-теги: <HEAD>, <TITLE>, <BODY> и т.д. Поскольку расширение нестандартное, Word не распознает содержащийся в файле HTML-код и интерпретирует его как обычный текст. Чтобы просмотреть документ в виде веб-страницы, выполните следующие действия:
1. Выберите команду Сервис  Параметры и перейдите на вкладку Общие.
2. Установите флажок Подтверждать преобразование при открытии (Confirm Conversion At Open).
3. Закройте и заново откройте документ.
4. В диалоговом окне Преобразование файла (Convert File), которое Word выведет на экран при открытии документа, выберите вариант HTML-документ (HTML Document) и нажмите кнопку OK.
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Когда веб-страница создана, необходимо опубликовать ее, то есть скопировать в папку на компьютер, на котором установлен веб-сервер, чтобы страница стала доступна в Сети или локальной сети компании.
Можно попробовать сохранить страницу в папке сервера прямо из Word. Это возможно когда папка веб-сервера находится, например, на вашем компьютере или в локальной сети (в сетевом окружении), или на FTP-узле, к которому у вас есть требуемый допуск, или на веб-узле, на котором установлен сервер Microsoft (таком как групповой веб-узел на базе Microsoft SharePoint Team Services).
Если нет возможности опубликовать веб-страницу прямо из Word, следует послать ее на веб-сервер с помощью FTP-программы, мастера публикации веб-страниц или других средств.
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В конце работы, я еще раз убедился в том, что программа Microsoft Word представляет собой чрезвычайно мощный и универсальный текстовый процессор, который можно применять для всех видов документов: писем, факсимильных сообщений, служебных записок, инструкций, технических описаний, книг и веб-страниц.
Основные преймущества Word перед другими программами:
· Работа со знакомым интерфейсом. Редактор Word является наиболее популярным приложением пакета Microsoft Office. Для работы с папками и файлами используется интрефейс, схожий с интерфейсом браузера Microsoft Internet Explorer.
· Позволяет просматривать информацию о компонентах веб-сайта. О статусе файлов, гиперссылок и других элементов веб-страниц можно узнать непосредственно в приложении Word.
· Использование стилистических тем при создании веб-страниц. Каждай тема формирует определенный стиль фона, текста, списков, баннеров, меню навигации и других элементов для каждой страницы веб-сайта.
· Возможность открывать и редактировать веб-страницу непосредственно на сервере. Word позволяет поддерживать работу с копией веб-страницы на локальном компьютере или сетевом диске, с последующей публикаций веб-страницы на сервере.
Несмотря на обширные функции, предостовляемые Microsoft Word, работать с ними совсем несложно. Разработчики сделали все возможное, чтобы работа над созданием веб-страниц превратилась в интересный, творческий процесс, чтобы за короткое время можно было создать качественные веб-страницы профессионального уровня. Microsoft Word, несомненно, должен быть под рукой у каждого, кто занимается созданием, редактированием и обновлением веб-страниц.
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